Basics of Computers - Introduction
Being a modern-day kid you must have used, seen, or read about computers. This is because they are an integral part of our everyday existence. Be it school, banks, shops, railway stations, hospital or your own home, computers are present everywhere, making our work easier and faster for us. As they are such integral parts of our lives, we must know what they are and how they function. Let us start with defining the term computer formally.
The literal meaning of computer is a device that can calculate. However, modern computers can do a lot more than calculate. Computer is an electronic device that receives input, stores or processes the input as per user instructions and provides output in desired format.
Input-Process-Output Model( components of computer)
Computer input is called data and the output obtained after processing it, based on user’s instructions is called information. Raw facts and figures which can be processed using arithmetic and logical operations to obtain information are called data.
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The processes that can be applied to data are of two types −
· Arithmetic operations − Examples include calculations like addition, subtraction, differentials, square root, etc.
· Logical operations − Examples include comparison operations like greater than, less than, equal to, opposite, etc.
The corresponding figure for an actual computer looks something like this −
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The basic parts of a computer are as follows −
· Input Unit − Devices like keyboard and mouse that are used to input data and instructions to the computer are called input unit.
· Output Unit − Devices like printer and visual display unit that are used to provide information to the user in desired format are called output unit.
· Control Unit − As the name suggests, this unit controls all the functions of the computer. All devices or parts of computer interact through the control unit.
· Arithmetic Logic Unit − This is the brain of the computer where all arithmetic operations and logical operations take place.
· Memory − All input data, instructions and data interim to the processes are stored in the memory. Memory is of two types – primary memory and secondary memory. Primary memory resides within the CPU whereas secondary memory is external to it.
Control unit, arithmetic logic unit and memory are together called the central processing unit or CPU. Computer devices like keyboard, mouse, printer, etc. that we can see and touch are the hardware components of a computer. The set of instructions or programs that make the computer function using these hardware parts are called software. We cannot see or touch software. Both hardware and software are necessary for working of a computer.
Characteristics of Computer
To understand why computers are such an important part of our lives, let us look at some of its characteristics −
· Speed − Typically, a computer can carry out 3-4 million instructions per second.
· Accuracy − Computers exhibit a very high degree of accuracy. Errors that may occur are usually due to inaccurate data, wrong instructions or bug in chips – all human errors.
· Reliability − Computers can carry out same type of work repeatedly without throwing up errors due to tiredness or boredom, which are very common among humans.
· Versatility − Computers can carry out a wide range of work from data entry and ticket booking to complex mathematical calculations and continuous astronomical observations. If you can input the necessary data with correct instructions, computer will do the processing.
· Storage Capacity − Computers can store a very large amount of data at a fraction of cost of traditional storage of files. Also, data is safe from normal wear and tear associated with paper.
Advantages of Using Computer
Now that we know the characteristics of computers, we can see the advantages that computers offer−
· Computers can do the same task repetitively with same accuracy.
· Computers do not get tired or bored.
· Computers can take up routine tasks while releasing human resource for more intelligent functions.
Disadvantages of Using Computer
Despite so many advantages, computers have some disadvantages of their own −
· Computers have no intelligence; they follow the instructions blindly without considering the outcome.
· Regular electric supply is necessary to make computers work, which could prove difficult everywhere especially in developing nations.
Booting
Starting a computer or a computer-embedded device is called booting. Booting takes place in two steps −
· Switching on power supply
· Loading operating system into computer’s main memory
· Keeping all applications in a state of readiness in case needed by the user
The first program or set of instructions that run when the computer is switched on is called BIOS or Basic Input Output System. BIOS is a firmware, i.e. a piece of software permanently programmed into the hardware.
If a system is already running but needs to be restarted, it is called rebooting. Rebooting may be required if a software or hardware has been installed or system is unusually slow.
There are two types of booting −
· Cold Booting − When the system is started by switching on the power supply it is called cold booting. The next step in cold booting is loading of BIOS.
· Warm Booting − When the system is already running and needs to be restarted or rebooted, it is called warm booting. Warm booting is faster than cold booting because BIOS is not reloaded.
· Definition: A control unit (CU) (or controller, same thing) is a piece of hardware that manages the activities of peripherals (separate devices attached to the computer, such as monitors, hard drives, printers, etc.) Control units found on personal computers are usually contained on a single printed circuit board. The control unit acts as a sort of "go-between," executing transfers of information between the computer's memory and the peripheral. Although the CPU (central processing unit-the "big boss" in the computer) gives instructions to the controller, it is the control unit itself that performs the actual physical transfer of data. 
· The control unit fetches one or more new instructions from memory (or an instruction cache), decodes them and dispatches them to the appropriate functional units to be executed. The control unit is also responsible for setting the latches in various data paths that ensure that the instructions are performed on the correct operand values stored in the registers. 
· In a CISCprocessor, the control unit is a small processor in its own right that executes microcode programs stored in a region of rom that prescribe the correct sequence of latches and data transfers for each type of macroinstruction. A RISC processor does away with microcode and most of the complexity in the control unit, which is left with little more to do than decode the instructions and turn on the appropriate functional units. 
· Functions of control Unit 
· • Regulate transfers of information between memory and I/O. 
· • Fetches and decodes instructions from microprograms. 
· • Responsible for correct instruction execution between a processor's many sub-units. 
· • Control unit converts received information into sequence of control signals, and transfer to computer processor. 
· • It controls data flow inside the computer processor. 
Basic characteristics about computer are:
1. Speed: - As you know computer can work very fast. It takes only few seconds for calculations that we take hours to complete. You will be surprised to know that computer can perform millions (1,000,000) of instructions and even more per second.
Therefore, we determine the speed of computer in terms of microsecond (10-6 part of a second) or nanosecond (10 to the power -9 part of a second). From this you can imagine how fast your computer performs work. 
2. Accuracy: - The degree of accuracy of computer is very high and every calculation is performed with the same accuracy. The accuracy level is 7. determined on the basis of design of computer. The errors in computer are due to human and inaccurate data. 
3. Diligence: - A computer is free from tiredness, lack of concentration, fatigue, etc. It can work for hours without creating any error. If millions of calculations are to be performed, a computer will perform every calculation with the same accuracy. Due to this capability it overpowers human being in routine type of work.  
4. Versatility: - It means the capacity to perform completely different type of work. You may use your computer to prepare payroll slips. Next moment you may use it for inventory management or to prepare electric bills. 
5. Power of Remembering: - Computer has the power of storing any amount of information or data. Any information can be stored and recalled as long as you require it, for any numbers of years. It depends entirely upon you how much data you want to store in a computer and when to lose or retrieve these data.  
6. No IQ: - Computer is a dumb machine and it cannot do any work without instruction from the user. It performs the instructions at tremendous speed and with accuracy. It is you to decide what you want to do and in what sequence. So a computer cannot take its own decision as you can.  
7. No Feeling: - It does not have feelings or emotion, taste, knowledge and experience. Thus it does not get tired even after long hours of work. It does not distinguish between users. 
8. Storage: - The Computer has an in-built memory where it can store a large amount of data. You can also store data in secondary storage devices such as floppies, which can be kept outside your computer and can be carried to other computers.
Computer - Hardware
Hardware represents the physical and tangible components of a computer, i.e. the components that can be seen and touched.
Examples of Hardware are the following −
· Input devices − keyboard, mouse, etc.
· Output devices − printer, monitor, etc.
· Secondary storage devices − Hard disk, CD, DVD, etc.
· Internal components − CPU, motherboard, RAM, etc.
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Relationship between Hardware and Software
· Hardware and software are mutually dependent on each other. Both of them must work together to make a computer produce a useful output.
· Software cannot be utilized without supporting hardware.
· Hardware without a set of programs to operate upon cannot be utilized and is useless.
· To get a particular job done on the computer, relevant software should be loaded into the hardware.
· Hardware is a one-time expense.
· Software development is very expensive and is a continuing expense.
· Different software applications can be loaded on a hardware to run different jobs.
· A software acts as an interface between the user and the hardware.
· If the hardware is the 'heart' of a computer system, then the software is its 'soul'. Both are complementary to each other.


Baiscs of Computers - Software Concepts
As you know, the hardware devices need user instructions to function. A set of instructions that achieve a single outcome are called program or procedure. Many programs functioning together to do a task make a software.
For example, a word-processing software enables the user to create, edit and save documents. A web browser enables the user to view and share web pages and multimedia files. There are two categories of software −
· System Software
· Application Software
· Utility Software
Let us discuss them in detail.
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System Software
Software required to run the hardware parts of the computer and other application software are called system software. System software acts as interface between hardware and user applications. An interface is needed because hardware devices or machines and humans speak in different languages.
Machines understand only binary language i.e. 0 (absence of electric signal) and 1 (presence of electric signal) while humans speak in English, French, German, Tamil, Hindi and many other languages. English is the pre-dominant language of interacting with computers. Software is required to convert all human instructions into machine understandable instructions. And this is exactly what system software does.
Based on its function, system software is of four types −
· Operating System
· Language Processor
· Device Drivers
Operating System
System software that is responsible for functioning of all hardware parts and their interoperability to carry out tasks successfully is called operating system (OS). OS is the first software to be loaded into computer memory when the computer is switched on and this is called booting. OS manages a computer’s basic functions like storing data in memory, retrieving files from storage devices, scheduling tasks based on priority, etc.
Language Processor
As discussed earlier, an important function of system software is to convert all user instructions into machine understandable language. When we talk of human machine interactions, languages are of three types −
· Machine-level language − This language is nothing but a string of 0s and 1s that the machines can understand. It is completely machine dependent.
· Assembly-level language − This language introduces a layer of abstraction by defining mnemonics. Mnemonics are English like words or symbols used to denote a long string of 0s and 1s. For example, the word “READ” can be defined to mean that computer has to retrieve data from the memory. The complete instruction will also tell the memory address. Assembly level language is machine dependent.
· High level language − This language uses English like statements and is completely independent of machines. Programs written using high level languages are easy to create, read and understand.
Program written in high level programming languages like Java, C++, etc. is called source code. Set of instructions in machine readable form is called object code or machine code. System software that converts source code to object code is called language processor. There are three types of language interpreters−
· Assembler − Converts assembly level program into machine level program.
· Interpreter − Converts high level programs into machine level program line by line.
· Compiler − Converts high level programs into machine level programs at one go rather than line by line.
Device Drivers
System software that controls and monitors functioning of a specific device on computer is called device driver. Each device like printer, scanner, microphone, speaker, etc. that needs to be attached externally to the system has a specific driver associated with it. When you attach a new device, you need to install its driver so that the OS knows how it needs to be managed.
Application Software
A software that performs a single task and nothing else is called application software. Application software are very specialized in their function and approach to solving a problem. So a spreadsheet software can only do operations with numbers and nothing else. A hospital management software will manage hospital activities and nothing else. Here are some commonly used application software −
· Word processing
· Spreadsheet
· Presentation
· Database management
· Multimedia tools
Utility Software
Application software that assist system software in doing their work is called utility software. Thus utility software is actually a cross between system software and application software. Examples of utility software include −
· Antivirus software
· Disk management tools
· File management tools
· Compression tools
· Backup tools

Memory Units
Memory units are used to measure and represent data. Some of the commonly used memory units are:
1) Bit: The computer memory units start from bit. A bit is the smallest memory unit to measure data stored in main memory and storage devices. A bit can have only one binary value out of 0 and 1.
2) Byte: It is the fundamental unit to measure data. It contains 8 bits or is equal to 8 bits. Thus a byte can represent 2*8 or 256 values.
3) Kilobyte: A kilobyte contains 1024 bytes.
4) Megabyte: A megabyte contains 1024 kilobytes.
5) Gigabyte: A gigabyte contains 1024 megabyte.
6) Terabyte: A terabyte contains 1024 gigabytes.


Basics of Computers - Primary Memory

Memory is required in computers to store data and instructions. Memory is physically organized as a large number of cells that are capable of storing one bit each. Logically they are organized as groups of bits called words that are assigned an address. Data and instructions are accessed through these memory address. The speed with which these memory addresses can be accessed determines the cost of the memory. Faster the memory speed, higher the price.
Computer memory can be said to be organized in a hierarchical way where memory with the fastest access speeds and highest costs lies at the top whereas those with lowest speeds and hence lowest costs lie at the bottom. Based on this criteria memory is of two types – primary and secondary. Here we will look at primary memory in detail.
The main features of primary memory, which distinguish it from secondary memory are −
· It is accessed directly by the processor
· It is the fastest memory available
· Each word is stored as well as
· It is volatile, i.e. its contents are lost once power is switched off
As primary memory is expensive, technologies are developed to optimize its use. These are broad types of primary memory available.
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RAM
RAM stands for Random Access Memory. The processor accesses all memory addresses directly, irrespective of word length, making storage and retrieval fast. RAM is the fastest memory available and hence most expensive. These two factors imply that RAM is available in very small quantities of up to 1GB. RAM is volatile but my be of any of these two types
DRAM (Dynamic RAM)
Each memory cell in a DRAM is made of one transistor and one capacitor, which store one bit of data. However, this cell starts losing its charge and hence data stored in less than thousandth of a second. So it needs to be refreshed thousand times a second, which takes up processor time. However, due to small size of each cell, one DRAM can have large number of cells. Primary memory of most of the personal computers is made of DRAM.
SRAM (SRAM)
Each cell in SRAM is made of a flip flop that stores one bit. It retains its bit till the power supply is on and doesn’t need to be refreshed like DRAM. It also has shorter read-write cycles as compared to DRAM. SRAM is used in specialized applications.
ROM
ROM stands for Read Only Memory. As the name suggests, ROM can only be read by the processor. New data cannot be written into ROM. Data to be stored into ROM is written during the manufacturing phase itself. They contain data that does not need to be altered, like booting sequence of a computer or algorithmic tables for mathematical applications. ROM is slower and hence cheaper than RAM. It retains its data even when power is switched off, i.e. it is non-volatile. ROM cannot be altered the way RAM can be but technologies are available to program these types of ROMs −
PROM (Programmable ROM)
PROM can be programmed using a special hardware device called PROM programmer or PROM burner.
EPROM (Erasable Programmable ROM)
EPROM can be erased and then programmed using special electrical signals or UV rays. EPROMs that can be erased using UV rays are called UVEPROM and those that can be erased using electrical signals are called EEPROM. However, handling electric signals is easier and safer than UV rays.
Cache Memory
Small piece of high speed volatile memory available to the processor for fast processing is called cache memory. Cache may be a reserved portion of main memory, another chip on CPU or an independent high speed storage device. Cache memory is made of fast speed SRAMs. The process of keeping some data and instructions in cache memory for faster access is called caching. Caching is done when a set of data or instructions is accesses again and again.
Whenever the processor needs any piece of data or instructions, it checks the cache first. If it is unavailable there, then the main memory and finally secondary memory is accessed. As cache has very high speed, time spent in accessing it every time is negligible as compared to time saved if data indeed is in the cache. Finding data or instruction in cache is called cache hit.
Basics of Computers - Secondary Memory
You know that processor memory, also known as primary memory, is expensive as well as limited. The faster primary memory are also volatile. If we need to store large amount of data or programs permanently, we need a cheaper and permanent memory. Such memory is called secondary memory. Here we will discuss secondary memory devices that can be used to store large amount of data, audio, video and multimedia files.
Characteristics of Secondary Memory
These are some characteristics of secondary memory, which distinguish it from primary memory −
· It is non-volatile, i.e. it retains data when power is switched off
· It is large capacities to the tune of terabytes
· It is cheaper as compared to primary memory
Depending on whether secondary memory device is part of CPU or not, there are two types of secondary memory – fixed and removable.
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Let us look at some of the secondary memory devices available.
Hard Disk Drive
Hard disk drive is made up of a series of circular disks called platters arranged one over the other almost ½ inches apart around a spindle. Disks are made of non-magnetic material like aluminum alloy and coated with 10-20 nm of magnetic material.
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Standard diameter of these disks is 14 inches and they rotate with speeds varying from 4200 rpm (rotations per minute) for personal computers to 15000 rpm for servers. Data is stored by magnetizing or demagnetizing the magnetic coating. A magnetic reader arm is used to read data from and write data to the disks. A typical modern HDD has capacity in terabytes (TB).
CD Drive
CD stands for Compact Disk. CDs are circular disks that use optical rays, usually lasers, to read and write data. They are very cheap as you can get 700 MB of storage space for less than a dollar. CDs are inserted in CD drives built into CPU cabinet. They are portable as you can eject the drive, remove the CD and carry it with you. There are three types of CDs −
· CD-ROM (Compact Disk – Read Only Memory) − The data on these CDs are recorded by the manufacturer. Proprietary Software, audio or video are released on CD-ROMs.
· CD-R (Compact Disk – Recordable) − Data can be written by the user once on the CD-R. It cannot be deleted or modified later.
· CD-RW (Compact Disk – Rewritable) − Data can be written and deleted on these optical disks again and again.
DVD Drive
DVD stands for Digital Video Display. DVD are optical devices that can store 15 times the data held by CDs. They are usually used to store rich multimedia files that need high storage capacity. DVDs also come in three varieties – read only, recordable and rewritable.
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Pen Drive
Pen drive is a portable memory device that uses solid state memory rather than magnetic fields or lasers to record data. It uses a technology similar to RAM, except that it is nonvolatile. It is also called USB drive, key drive or flash memory.
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Blu Ray Disk
Blu Ray Disk (BD) is an optical storage media used to store high definition (HD) video and other multimedia filed. BD uses shorter wavelength laser as compared to CD/DVD. This enables writing arm to focus more tightly on the disk and hence pack in more data. BDs can store up to 128 GB data.
Computer - Input Devices
Following are some of the important input devices which are used in a computer −
· Keyboard
· Mouse
· Joy Stick
· Light pen
· Track Ball
· Scanner
· Graphic Tablet
· Microphone
· Magnetic Ink Card Reader(MICR)
· Optical Character Reader(OCR)
· Bar Code Reader
· Optical Mark Reader(OMR)
Keyboard
Keyboard is the most common and very popular input device which helps to input data to the computer. The layout of the keyboard is like that of traditional typewriter, although there are some additional keys provided for performing additional functions.
[image: Keyboard]
Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 keys are also available for Windows and Internet.
The keys on the keyboard are as follows −
	S.No
	Keys & Description

	1
	Typing Keys
These keys include the letter keys (A-Z) and digit keys (09) which generally give the same layout as that of typewriters.

	2
	Numeric Keypad
It is used to enter the numeric data or cursor movement. Generally, it consists of a set of 17 keys that are laid out in the same configuration used by most adding machines and calculators.

	3
	Function Keys
The twelve function keys are present on the keyboard which are arranged in a row at the top of the keyboard. Each function key has a unique meaning and is used for some specific purpose.

	4
	Control keys
These keys provide cursor and screen control. It includes four directional arrow keys. Control keys also include Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc).

	5
	Special Purpose Keys
Keyboard also contains some special purpose keys such as Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and Print Screen.


Mouse
Mouse is the most popular pointing device. It is a very famous cursor-control device having a small palm size box with a round ball at its base, which senses the movement of the mouse and sends corresponding signals to the CPU when the mouse buttons are pressed.
Generally, it has two buttons called the left and the right button and a wheel is present between the buttons. A mouse can be used to control the position of the cursor on the screen, but it cannot be used to enter text into the computer.
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Advantages
· Easy to use
· Not very expensive
· Moves the cursor faster than the arrow keys of the keyboard.
Joystick
Joystick is also a pointing device, which is used to move the cursor position on a monitor screen. It is a stick having a spherical ball at its both lower and upper ends. The lower spherical ball moves in a socket. The joystick can be moved in all four directions.
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The function of the joystick is similar to that of a mouse. It is mainly used in Computer Aided Designing (CAD) and playing computer games.
Light Pen
Light pen is a pointing device similar to a pen. It is used to select a displayed menu item or draw pictures on the monitor screen. It consists of a photocell and an optical system placed in a small tube.
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When the tip of a light pen is moved over the monitor screen and the pen button is pressed, its photocell sensing element detects the screen location and sends the corresponding signal to the CPU.
Track Ball
Track ball is an input device that is mostly used in notebook or laptop computer, instead of a mouse. This is a ball which is half inserted and by moving fingers on the ball, the pointer can be moved.
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Since the whole device is not moved, a track ball requires less space than a mouse. A track ball comes in various shapes like a ball, a button, or a square.
Scanner
Scanner is an input device, which works more like a photocopy machine. It is used when some information is available on paper and it is to be transferred to the hard disk of the computer for further manipulation.
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Scanner captures images from the source which are then converted into a digital form that can be stored on the disk. These images can be edited before they are printed.
Digitizer
Digitizer is an input device which converts analog information into digital form. Digitizer can convert a signal from the television or camera into a series of numbers that could be stored in a computer. They can be used by the computer to create a picture of whatever the camera had been pointed at.
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Digitizer is also known as Tablet or Graphics Tablet as it converts graphics and pictorial data into binary inputs. A graphic tablet as digitizer is used for fine works of drawing and image manipulation applications.
Microphone
Microphone is an input device to input sound that is then stored in a digital form.
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The microphone is used for various applications such as adding sound to a multimedia presentation or for mixing music.
Magnetic Ink Card Reader (MICR)
MICR input device is generally used in banks as there are large number of cheques to be processed every day. The bank's code number and cheque number are printed on the cheques with a special type of ink that contains particles of magnetic material that are machine readable.
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This reading process is called Magnetic Ink Character Recognition (MICR). The main advantages of MICR is that it is fast and less error prone.
Optical Character Reader (OCR)
OCR is an input device used to read a printed text.
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OCR scans the text optically, character by character, converts them into a machine readable code, and stores the text on the system memory.
Bar Code Readers
Bar Code Reader is a device used for reading bar coded data (data in the form of light and dark lines). Bar coded data is generally used in labelling goods, numbering the books, etc. It may be a handheld scanner or may be embedded in a stationary scanner.
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Bar Code Reader scans a bar code image, converts it into an alphanumeric value, which is then fed to the computer that the bar code reader is connected to.
Optical Mark Reader (OMR)
OMR is a special type of optical scanner used to recognize the type of mark made by pen or pencil. It is used where one out of a few alternatives is to be selected and marked.
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It is specially used for checking the answer sheets of examinations having multiple choice questions.
Computer - Output Devices

Following are some of the important output devices used in a computer.
· Monitors
· Graphic Plotter
· Printer
Monitors
Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It forms images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the image depends upon the number of pixels.
There are two kinds of viewing screen used for monitors.
· Cathode-Ray Tube (CRT)
· Flat-Panel Display
Cathode-Ray Tube (CRT) Monitor
The CRT display is made up of small picture elements called pixels. The smaller the pixels, the better the image clarity or resolution. It takes more than one illuminated pixel to form a whole character, such as the letter ‘e’ in the word help.
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A finite number of characters can be displayed on a screen at once. The screen can be divided into a series of character boxes - fixed location on the screen where a standard character can be placed. Most screens are capable of displaying 80 characters of data horizontally and 25 lines vertically.
There are some disadvantages of CRT −
· Large in Size
· High power consumption
Flat-Panel Display Monitor
The flat-panel display refers to a class of video devices that have reduced volume, weight and power requirement in comparison to the CRT. You can hang them on walls or wear them on your wrists. Current uses of flat-panel displays include calculators, video games, monitors, laptop computer, and graphics display.
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The flat-panel display is divided into two categories −
· Emissive Displays − Emissive displays are devices that convert electrical energy into light. For example, plasma panel and LED (Light-Emitting Diodes).
· Non-Emissive Displays − Non-emissive displays use optical effects to convert sunlight or light from some other source into graphics patterns. For example, LCD (Liquid-Crystal Device).
Printers
Printer is an output device, which is used to print information on paper.
There are two types of printers −
· Impact Printers
· Non-Impact Printers
Impact Printers
Impact printers print the characters by striking them on the ribbon, which is then pressed on the paper.
Characteristics of Impact Printers are the following −
· Very low consumable costs
· Very noisy
· Useful for bulk printing due to low cost
· There is physical contact with the paper to produce an image
These printers are of two types −
· Character printers
· Line printers
Character Printers
Character printers are the printers which print one character at a time.
These are further divided into two types:
· Dot Matrix Printer(DMP)
· Daisy Wheel
Dot Matrix Printer
In the market, one of the most popular printers is Dot Matrix Printer. These printers are popular because of their ease of printing and economical price. Each character printed is in the form of pattern of dots and head consists of a Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) which come out to form a character which is why it is called Dot Matrix Printer.
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Advantages
· Inexpensive
· Widely Used
· Other language characters can be printed
Disadvantages
· Slow Speed
· Poor Quality
Daisy Wheel
Head is lying on a wheel and pins corresponding to characters are like petals of Daisy (flower) which is why it is called Daisy Wheel Printer. These printers are generally used for word-processing in offices that require a few letters to be sent here and there with very nice quality.
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Advantages
· More reliable than DMP
· Better quality
· Fonts of character can be easily changed
Disadvantages
· Slower than DMP
· Noisy
· More expensive than DMP
Line Printers
Line printers are the printers which print one line at a time.
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These are of two types −
· Drum Printer
· Chain Printer
Drum Printer
This printer is like a drum in shape hence it is called drum printer. The surface of the drum is divided into a number of tracks. Total tracks are equal to the size of the paper, i.e. for a paper width of 132 characters, drum will have 132 tracks. A character set is embossed on the track. Different character sets available in the market are 48 character set, 64 and 96 characters set. One rotation of drum prints one line. Drum printers are fast in speed and can print 300 to 2000 lines per minute.
Advantages
· Very high speed
Disadvantages
· Very expensive
· Characters fonts cannot be changed
Chain Printer
In this printer, a chain of character sets is used, hence it is called Chain Printer. A standard character set may have 48, 64, or 96 characters.
Advantages
· Character fonts can easily be changed.
· Different languages can be used with the same printer.
Disadvantages
· Noisy
Non-impact Printers
Non-impact printers print the characters without using the ribbon. These printers print a complete page at a time, thus they are also called as Page Printers.
These printers are of two types −
· Laser Printers
· Inkjet Printers
Characteristics of Non-impact Printers
· Faster than impact printers
· They are not noisy
· High quality
· Supports many fonts and different character size
Laser Printers
These are non-impact page printers. They use laser lights to produce the dots needed to form the characters to be printed on a page.
[image: Laser Printer]
Advantages
· Very high speed
· Very high quality output
· Good graphics quality
· Supports many fonts and different character size
Disadvantages
· Expensive
· Cannot be used to produce multiple copies of a document in a single printing
Inkjet Printers
Inkjet printers are non-impact character printers based on a relatively new technology. They print characters by spraying small drops of ink onto paper. Inkjet printers produce high quality output with presentable features.
[image: Inkjet Printer]
They make less noise because no hammering is done and these have many styles of printing modes available. Color printing is also possible. Some models of Inkjet printers can produce multiple copies of printing also.
Advantages
· High quality printing
· More reliable
Disadvantages
· Expensive as the cost per page is high
· Slow as compared to laser printer
Computer - Operating System
The Operating System is a program with the following features −
· An operating system is a program that acts as an interface between the software and the computer hardware.
· It is an integrated set of specialized programs used to manage overall resources and operations of the computer.
· It is a specialized software that controls and monitors the execution of all other programs that reside in the computer, including application programs and other system software.
[image: Operating System]
Objectives of Operating System
The objectives of the operating system are −
· To make the computer system convenient to use in an efficient manner.
· To hide the details of the hardware resources from the users.
· To provide users a convenient interface to use the computer system.
· To act as an intermediary between the hardware and its users, making it easier for the users to access and use other resources.
· To manage the resources of a computer system.
· To keep track of who is using which resource, granting resource requests, and mediating conflicting requests from different programs and users.
· To provide efficient and fair sharing of resources among users and programs.
Characteristics of Operating System
Here is a list of some of the most prominent characteristic features of Operating Systems −
· Memory Management − Keeps track of the primary memory, i.e. what part of it is in use by whom, what part is not in use, etc. and allocates the memory when a process or program requests it.
· Processor Management − Allocates the processor (CPU) to a process and deallocates the processor when it is no longer required.
· Device Management − Keeps track of all the devices. This is also called I/O controller that decides which process gets the device, when, and for how much time.
· File Management − Allocates and de-allocates the resources and decides who gets the resources.
· Security − Prevents unauthorized access to programs and data by means of passwords and other similar techniques.
· Job Accounting − Keeps track of time and resources used by various jobs and/or users.
· Control Over System Performance − Records delays between the request for a service and from the system.
· Interaction with the Operators − Interaction may take place via the console of the computer in the form of instructions. The Operating System acknowledges the same, does the corresponding action, and informs the operation by a display screen.
· Error-detecting Aids − Production of dumps, traces, error messages, and other debugging and error-detecting methods.
· Coordination Between Other Software and Users − Coordination and assignment of compilers, interpreters, assemblers, and other software to the various users of the computer systems.
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2.1 INTRODUCTION TO WORD
 			Microsoft word is a full featured word processing program which can be used for any work involving creating and managing text.

Advantage of word:
 
	Web page creation,
	Creating Mail merge,
	Working with table and indexes,
	Cut, copy, paste functions,
	Aligning of documents,
	Spelling and grammar check facility,
	Formatting documents,
	Insertion of pictures and documents.

Opening a word document
			
1.	Start-> programs-> Ms Office-> Microsoft word 2007


In word contain number of components. Some components are 
1.	Title bar
2.	Menu bar
3.	Standard toolbar 
4.	Scroll bar
5.	Ruler

 

	
o	Title bar contains word icon and Software name as Microsoft word, Minimize, Maximize and close button.
o	In menu bar contains number of menu. They are
Home			Mailings		
Insert 			Review
Page layout 		View
References 		Help

Home menu

 




Insert Menu

 

Page layout menu

 

References Menu

 

Mailings Menu

 
Review menu

 

View menu

 


2.2 CREATING A WORD DOCUMENT

 		Word documents are the text documents may be files or letters or books.
  
•	Start-> programs-> Ms Office-> Microsoft word 2007

•	Then click the new from file menu.(File->New)

•	Click the blank document and then create button.

The screen will automatically display the new document. Then typing the text. If the line will be end press the enter for next line. 
Save the document with required drive or folder.(File->save)
Example:  Select D drive and, Studies folder and type the file name.
        D:\Studies\myfile1.doc,(document)
         The extension .doc is automatic and need not be typed.

o	Creating New Document: File->New or Ctrl+N.
o	Opening an existing Document: File->Open or Select the file and click.
o	Closing the  Document: File->close or Alt+f4.
o	Saving the Document: File->Save or Ctrl+S.
o	Save as method: File->Save as->Select folder or Drive->
 		       Type name of the file->click save
o	Print the document :File->print or Ctrl+p.

2.3 BUSINESS LETTERS

o	Business letters can be easily created in the word documents. There are Tabs such as General, Letters and Faxes, Memos, Office Documents, Publications, Reports and Web pages.
o	Template means standardized form for easy formatting.

 


o	File->New->Installed Templates.
o	The above dialog box appear.
o	Select the template if those we need.




 2.4 EDITING
o	Editing is the process of making modification in the document. Text can be added, deleted, copied, and cut ,paste  operations can be done.
o	Find and replace options can be used to change the letters.
o	Spell and check grammar check can be done.
o	The line will be started by pressing enter key and then tab key to set the initial space for the first line. 
o	The full sentence will be selected by placing the mouse pointer on the word and use the shift key and press -> arrow button.
 Editing the document
1.	Undo and Redo:
o	Undo:
If the undo button is pressed then the last change made is deleted and the original text is displayed.
Undo can be done in two ways:
	Click undo button.
	Press ctrl+Z.
	Click the undo command from the Home menu.
o	Redo:
If the Redo button is pressed then the changes made will be displayed in the document. 
Undo can be done in two ways:
	Click redo button.
	Press ctrl+Y.
	Click the redo command from the Home menu
2.	Moving the text:
o	The text can be moved from one place to another. The text will be moved from one document to another document or same document.
o	The text is move by cut and copy and paste option.
o	Cut can be done in three ways:
	Press ctrl+X.
	Click the cut button from the Home menu
o	Paste can be done in three ways:
	Press ctrl+V.
	Click the paste button from the Home menu
o	Copy can be done in three ways
	Press ctrl+C.
	Click the copy button from the Home menu


3.	Recently used File
o	The recently used files may have to be opened.  Click the office button and select the recently used files.
4.	Formatting the text.
o	Text in the document can be formatted in MS word. The document can contain various styles, fonts, colors, etc.
o	The styles may be bold face, underline, italic or may be of various sizes.

 
o	The  type may be Arial, Times New Roman and font size may be 6,8,10,12,14 …
5.	Editing command buttons.

Left arrow		  Move cursor to one character left
Right arrow		  Move cursor to one character right
Ctrl+left arrow		Previous word
Ctrl+Right arrow	Next word
End			End of the same line
Home			Beginning of the same line
Up arrow		Line above
Down arrow		Line below
Ctrl+Up arrow		Previous page
Ctrl+Down arrow	Next page
PageUp key		Previous screen page
Page down key		Next screen page
Crtl+Pageup		Previous page top
Crtl+Pagedown	Next page top
Ctrl+Home		first line beginning
Ctrl+End		End of the document

The character can be inserted in the specific places in Insert mode. If the  character is inserted inside of the line when the insert mode in on.

 
2.5 INSERTING OBJECTS

Graphics can be inserted in the word document. The graphics  can be inserted  using picture and clip art.
1.	Insert  Picture 
To insert a picture which are saved to our computer.
2.	Insertclipart
Click the clipart twice or select the art and click the insert button.
Now the picture and clipart will be inserted.

 
  


 

 

2.6	FORMATTING DOCUMENTS

The document is aligned in various formats. Some of them 
a)	Formatting of  Font ,Font size, Font type and Font style.
b)	Paragraph Indents
c)	Paragraph Alignments
d)	Auto format
e)	Bullets and Numbering
f)	Table and grid lines
g)	Header and footer
h)	Line Spacing

Paragraph Alignments
	Paragraph margins can be changed for each and every  paragraph.
Align the paragraph in Left, Right and center and Justify.
Bullets and Numbering
	To list the line or text using bullets and numbering.
Homeselect the button bullets and numbering. 



 

 
 
•	Type the first line and select the first line set the bullet or number for the list.
•	Next type the second line the bullet or number will be automatically come.

2.7	SPELLING CHECK AND GRAMMER CHECK
o	The documents may have some spelling mistakes or grammar mistakes or both.
o	 A entire document or specific page may be corrections or finding text, etc. Options are available for setting different types of languages.
o	 Ignore, Ignore all, change, change all and other functions are available in the dialog box.
i)	Find
o	If find the word in the document in the specific page selected, then open the document by clicking.
o	Click the Find command in the home menu.

 

o	Click the button  find next, it display the word (text)in the  whole document.
ii)  Replace
o	If want to replace the one word to another.
o	Click the replace command in the home menu.

 

o	Click the button replace of replace all.
o	If click replace all the words click will be changed as select.
iii) Spelling and grammar check
o	It is used for check the words spelling and grammar.
o	Type the word  and click the following commands for checking the spelling.
o	ReviewSpelling and grammar check

Example:
			Moder

			 

o	Select the any one of the button in the dialog box.
iv)  Auto correct
o	If typing errors are done , then changes can take place automatically.
o	For example, if  you  type ‘teh’, then it will be automatically changed as the .
o	If you type ‘adn’then  it will be changed as ‘and’.
  
2.8	BOOK MARKS
i)	Book Mark
o	Book marks are specific location in the Word documents and these are generally used to identify the locations of the tables, chapters and objects.
o	Click InsertBook markDialog boxEnter book mark nameClick Go

 

ii) Cross Reference
o	Cross reference is the reference to any other item.
o	The item may or may not be in the same document.
o	For this purpose hyperlinks are to be created.
iii) Text Box
o	Text Boxes are the containers for text.
o	They can be positioned on a page and they can be sized. 
o	InsertText box. There are number of textbox template displayed.
o	Type a quote from the document or the summary of an interesting point.
2.9 WORD COUNT
o	It provides information relating to words, pages, etc.
o	Word document is used to cont pages, words, characters, characters with spaces, Paragraphs and lines in the document.
o	Reviewword count.

 
 	Thesaurus
o	Thesaurus means the alternate word and this facility is available is MS word.
o	Thesaurus dialog box displays synonyms for the highlighted word.
o	 This facility helps to use an alternate word in the place of existing word. 
 	Tabs
		Using tab key the statement can be either left aligned or center aligned or justify.

 	Header and Footer
o	In insert menu select the header and footer command. Then dotted lines appear in the top of the page with small tool box. 
o	Type the required heading, insert time, date, use page number button.
o	Click the footer section use the commands for date, time, page number etc.
 	Print preview
o	Click the print preview button the print preview page applicable.
o	User views the document how the document will be printed on the page.

2.10 WORKING WITH TABLES
Tables can be inserted into the document using the following commands. Inserttable.
The table will be inserted following the ways:
1.	Draw table.
2.	Insert Table.
3.	Select the  row and column.

 
	
	

a)	Border and shadow:
Select borders and shading command from right click the table and select the command.
The below dialog box will be appear.

 
 
	Choose the border style and color and width of the table.

Similarly select the shading of the table. 








 


Now the table displayed in the following manner

	
	

The table has number of options for formatting.


Using the table we can crate student personal details, academic details and employee details and etc.

2.11 	MAIL MERGE	
	  
o	When the same letter or document is to be addressed to various people, the mail merge can be used. It is very useful and powerful addition in windows 98.
o	Letters, envelopes and mailing labels can be printed in a beautiful manner.
o	The master document and data files to be created and merged.
o	Example:
Interview letters, business letters, circulars to be printed at the time number of agents and staff.

Method for Mail merge:
   
	Click the Mailings menu and select the step by step mail wizard.
	Using  6 step we can create Mail merge.
 

 	First step choose the type of the document:
1.	Letter
2.	E-mail message
3.	Envelopes
4.	Labels
5.	Directory.

 

 	Second step choose starting of the document:
1.	Use the current document.
2.	Start from a template.
3.	Start from existing document.
 

 	Third step select recipients:
1.	Use an existing list.
2.	Select from outlook contacts
3.	Type a new list.

Select the option type a new list and click create link. The following dialog box will be appear. 

 

o	Select the number of users and address using  new entry button.
o	Click the ok button and give the name of the data source and click the save  button
o	The new list will be created.

 	Next step type the letter.

The title and name , address are select in option “More items”

			Business

From
  	XXXX
 YYYY

To
	Siva
Hemanth
HMST
S.M Nagar
Trichy
Tamilnadu
My dear staff members, 
		I happy to inform you all. Our company delivery a new product this month.	

Thanking You
	
						With regards
						    Xxxx



			Business

From
  	XXXX
 YYYY

To
	Siva
Hemanth
HMST
S.M Nagar
Trichy
Tamilnadu
My dear staff members, 
		I happy to inform you all. Our company delivery a new product this month.	

Thanking You
	
						With regards
						    Xxxx

VALLUVAR COLLEGE OF SCIENCE AND MANAGEMENT ,  KARUR.
	          		DEPETMENT OF COMMERCE
			OFFICE PROGRAMMING

Introduction to Spreadsheet (MS-Excel):
	Spreadsheet is an Electronic Worksheet. It is used to store information in the memory of the computer.
	It is desired way for calculation and display of information.
	Worksheet is the Electronic sheet where the calculations are given automatically as per instruction.
	Spreadsheet is an alternate for the normal ledger, pen, pencil, and calculator.
	Worksheet can show results in the form of graphs, charts and diagrams.
Feature of Spreadsheet
	Worksheet calculations and recalculations are automatic.
	Accuracy in results. Results will not change.
	Size modifications are easy. 
	Information in the spreadsheet can be stored in desired form.
	Merging is possible in worksheet.
	Mathematical function is done easily.
	Ascending and descending order can be made.
	Data in the worksheet can be stored in desired from.
Application of Worksheet
	Ledger.
	Banking forms
	Pay rolls
	Admission Lists
	Tax Calculation
	Billing Aspects
	Mathematical Calculation
	Budgets
	Banking Forms
	Annual Reports
What is workbook and worksheet?
 	Workbook is a file in MS Excel that holds worksheets. 
 	Worksheet is composed of columns and rows that are similar to an accounting ledger. It displays characters like letters, and numbers, and can do computations
How to open MS-Excel:

1)   Start


 All Programs


 Microsoft Office 2007		


 Microsoft Excel 2007   

2) Double click on the icon on desktop 
   
Parts of MS-Excel window

	Title bar.
	Menu bar.
	Workbook button.
	Tool bar.
	Formula bar.
	Active cell.
	Cell Address.
	Row header.
	Column header.
	Sheet tab
	Status bar


MS-Excel Window:	
						
 		

1.	Title Bar- It gives the software name and file name.
i.	It has three buttons. 1) Minimize 2) Maximize 3) Close.
2.	Menu Bar-The menu bar is a collection of useful menus. Each menu contains a list of command perform a specific task.
3.	Workbook buttons.
4.	Tool Bar-The tool bar located below the menu bar. The tool bar display options and buttons specific to the menu.
5.	Formula Bar-Located above the worksheet, this area displays the contents of the active cell. It can also be used for entering or editing data and formulas.
6.	Active cell-In an Excel 2007 worksheet, the cell with the black outline. Data is always entered into the active cell.
7.	Cell Address-Located previous to the formula bar, the Box displays the cell reference or the name of the active cell.
8.	Row header-a number used to identify the row
9.	Column header-a letter used to identify the column
10.	Sheet tab-represent the sheet name
11.	Status Bar-displays the information about the selected command.



Home Menu:
 

Insert Menu:
 

Page Layout Menu:
 

Formulas Menu:
 





Data Menu:
 

Review Menu:
 

View Menu:
 

   

Some Terms In Ms-Excel

•Workbook–An Excel file containing several worksheets
•Worksheet –Rectangular grid of rows & columns that labels and values are inserted into
•Cell‐The intersection of a row and column, identified by an address
          (ex. A1, F4, Z55)
•Value–Numerical data in a cell
•Label–Non‐numerical data in a cell
•Table –A logically distinct group of cells, visually distinguished with borders and shading
Building Worksheet

	Rows and columns in the screen from the worksheet area.  
	The input data are given in this area and result can be displayed in same area.
	The data fed results of the calculations, graphs and charts are shown in this area.
	There are 256 columns and 16,384 rows in the worksheet.
	The rows are numbered from 1 t0 16,384.  The columns are numbered
as A to Z then AA, AB, AC,… ,BA, BB etc.
	Active cell can be identified  by its thick border area and it is the current active cell
	The data fed into the computer at that times will be stored in the particular cell .
	For selecting cell, 
Keys			Selection of cell
				Next right cell in the same row.
				Left cell in the same row.
				Cell below the current cell next row.
				Cell above the current cell row above.
Tab			Next right cell in the same row.
Shift+tab			Left cell in the same row.

Entering data in worksheets
	The cells can have values and formula.
	The values may be character or numerals. 
	The word length should not be more than 255 characters.
Example:
 		2225, 22.55, +22.29, #045, -22.25, John, Accounts.
	When the data is being entered, 
•	The words are displayed in formula bar.
•	The status bar shows enter.
•	Now the three buttons are displayed in the middle part of formula bar ,
Left button—Cancel button
Middle Button—Confirm 
Right button—built in functions
	The error in the data entered cell can be modified by backspace key.
	If enter key is pressed then the changes in the data cell can be made by selecting the cell and by modifying it in the formula bar.
	Example:
Type the following mark statement:
Rollno	Name		Mark1 	Mark2	Total	     Average


               

Using formula:
	Formula can be entered in cells for setting values.
	In above example we enter the name and mark , the total and average are find using the formula.
	We use the formula use the following commands
•	Click the formula menu.
•	Select the option auto sum and select the sum option.
•	The formula is displayed in the formula bar.

 


Editing Cells
	Editing is the process of making changes, modification, or corrections in the data cell as well as positioning data as per requirements.
	Data can be edited only if the concerned cell is made active.

Auto Fill
	Auto fill is the technique used to enter automatic entries in the cell.
	 While entering data numbers, months, or dates, the first two items are to be typed. 
	Select both cells.
	 Place the cursor on the right bottom corner of the selected cells.
	 A plus mark appears. 
	Drag the plus mark to the required cells.
	 Now the data is automatically entered in the cells.
  

 

Formatting Cells
1) Change the font size, type , style:

 

	User selects the font color, size and type as they need it.

2) Change the number format 
 
3) Change the font alignment
 


4)  Change the cell border.
 
5) Change the cell background color
 
6) Change the cell size
	Select the home menu.
	Choose the option Format.
 
CELL SIZE
i)Row Height
	If we want to change the cell row click the option row height.
	The following dialog box appears. Enter the size of the row (or) using the arrow keys for specifies the size.
	Click the ok button.
            
ii) Column width:
	If we want to change the cell width click the option column width.
	The following dialog box appears. Enter the size of the column (or) using the arrow keys for specifies the size.
	Click the ok button.
           
iii) Auto fit row height, Auto fit column width
	If we want to default row size and column width select the option auto fit row height and auto fit column width.
	The default size of column width is 8.43 and row height is 15.
VISIBILITY
	The visibility option has the following options:
1.	Hide row
2.	Hide column
3.	Hide sheet
4.	Unhide row
5.	Unhide column
6.	Unhide sheet.
ORGANIZE SHEET
	The organize sheet option has the following options:
1.	Rename sheet
2.	Move or copy sheet
3.	Tab color.
	Move or copy sheet has the following dialog box.
       
  7) Insert row and columns.
	User insert the following:
•	Insert Cells.
•	Insert sheet rows.
•	Insert sheet columns.
•	Insert sheet.
	User click the option insert cell the following dialog box appears.
	Select the option if we need.

 

	Insert sheet row and insert column options are automatically insert row and column.
	Insert sheet option are used to entire full sheet to the workbook.
Working with Functions
	Functions can be pasted in the cells using the Function button in the toolbar.
Select the cell in which the answer is requiredClick Formulas Button in the Standard toolbarClick the insert function select the functionClick.
Example:
 
Select E2 cell Click Formulas Button in the Standard toolbarClick the insert function Select all functionChoose sum optionClick OKNow the result is given in the cell.
 
Statistical and various mathematical function are in MS-Excel. Some of the functions are performed:
1.	Mathematical functions.
2.	Statistical functions.
3.	Logical Functions.
4.	Trigonometric Functions.
5.	Text Functions.
6.	Date and Time.
MATHEMATICAL FUNCTIONS
1.	ABS function – returns the absolute value of the number without sign. Eg:=ABS (5*-2)returns 10; that is, absolute value of the number.
2.	COUNTIF function- counts the number of cells within the range of given  condition.  Values in C2:C4(89,78,65).                                                                  Eg: =COUNTIF(C2:C4,”>70”)returns 2
3.	EXP function- returns the exponent value. E.g:=EXP(1) returns 2.7182818
4.	FACT function- returns the factorial of the number.                                    E.g: FACT(5) returns 150   
5.	INT function- returns the number down to the nearest integer.                    E.g: INT(7.2)returns 7   
6.	LOG function- returns the logarithm of the number. Default base is 10.     E.g: =LOG(4)returns 0.60206     
7.	EVEN function –returns rounds the number to the nearest even integer.    E.g: =EVEN(7.5)returns 8  
8.	ODD function- returns rounds the number to the next odd integer.             E.g: = ODD(7.6) returns 9
9.	PRODUCT function – returns the multiples of all numbers in the argument. E.g:=PRODUCT(2,5,9) returns 90.
10.	SUM function- returns the sum of all numbers in the argument.  E.g:=SUM(2,5,9)returns 16.
STATISTICAL FUNCTIONS
1.	MAX function- returns the max value in the argument.                               E.g: =MAX(9,2,5) returns 9  
2.	MIN function- returns the min value in the argument.                                E.g: =MIN(9,2,5) returns 2  
3.	STDEV function- returns the max value in the argument.                               E.g: =STDEV(9,2,5) returns  3.511885
4.	VAR function- returns the max value in the argument.                               E.g: =MAX(9,2,5) returns 12.33333 
5.	COUNT function – counts the number of cells in a range that contain number.  E.g: =COUNT(9,2,5) returns 3
LOGICAL FUNCTIONS
1. AND function- Checks whether all arguments are true.	                         
E.g:=AND(22>29,05>10)returns TRUE.
       =AND(29>22,10>22)returns FALSE.  	               
 2. OR function –  Check whether any one of the argument is true. It returns false when all arguments are false.  
    E.g:=OR(22>29,05>10)returns TRUE.
       =OR(29>22,05>22)returns TRUE.
       =OR(29>22,22>10)returns FALSE.  	
3. NOT function-  Changes FALSE to TRUE (or) TRUE to FALSE.                
E.g:=NOT(3>5)returns TRUE.
       =NOT(5>3)returns FALSE.  	               
4. IF function-  Check whether a condition is met, and returns  one value if TRUE, and another value if FALSE.

TRIGONOMETRIC FUNCTION
1.	 COS function- returns the Cosine value of the given angle.  E.g:=COS(30)returns0.154
2.	 SIN function- returns the sine value of the given angle.  E.g:=SIN(60)returns  -0.30481
3.	TAN function- returns the tan value of the given angle.  E.g:=COS(30)returns  -6.4053

TEXT FUNCTION
1.	CHAR function- returns the character equivalent to the ASCII value specified.  E.g: = CHAR(66)returns B 
2.	CODE function- returns ASCII value for the first character in the argument. E.g:= CODE(BCA) returns 66
3.	EXACT function- converts two strings and returns TRUE if they are exactly matched, otherwise FALSE is returned.                                                       E.g: =EXACT(“EXCEL”, “excel”)returns FALSE.
4.	LEN function- returns the length of the string.                                                E.g: = LEN(“MICROSOFT”) returns 9 
5.	LOWER function- converts all uppercase characters into lowercase characters. E.g: = LOWER(MICROSOFT EXCEL) returns microsoft excel
6.	UPPER function- converts all lowercase characters into uppercase characters. E.g: = UPPER(microsoft excel) returns MICROSOFT EXCEL
7.	LEFT function- retrieve a specific number of characters from the left of the string. E.g:=LEFT(“MICROSOFT”,5) returns MICRO
8.	RIGHT function- retrieve a specific number of characters from the right of the string. E.g:=RIGHT(“MICROSOFT”,4) returns SOFT
DATE and TIME FUNCTION
1.	NOW()- returns the date and time in the current system.
2.	DATE function- =DATE(year/month/day)returns  year, month and day in the format. E.g: =DATE(2017,01,01) returns 01/01/2017
3.	TIME function – returns the time of the specified number. E.g: =TIME(18,18,18) returns 6.18 pm
4.	HOUR function . E.g:HOUR(0.1111)returns 2
5.	MINUTE function. E.g: MINUTE(0.22)returns 1/16/00
6.	SECOOND function E.g:SECOND(0.22)returns 48   
                                 
Working with charts.
	Charts are used to provide the data in clear format.
	 Charts are classified as line, bar, stacked bar, pie, XY area 3D bar. 
	Charts can be easily creates and the process is simple.
	Chart wizard  can be used to draw charts.

Chart Wizard
	Chart wizard is used to draw charts in the worksheet or in a different or separate paper.
	Chart may be  
1.	Column Chart    7. Bar diagram
2.	Line graph          8.Pie diagram
3.	XY scatter          9.Area
4.	Surface               10.Bubble
5.	Cylinder             11.Cone
6.	Pyramid             12.Stock
	To insert the chart use the following steps.
1.	Click the insert menu.
2.	Select the charts option.
3.	Click any one of the style and click ok button.
 
	Create the table.

 

	Select the chart type. Now the chart will be shown, selected chart type.

           

Change the Chart type:
	To change the chart type of chart , click the chart and click design menu and change the chart type.
 


 


Chart moving and Resizing
	Charts can be moved from one area to another or the size of the chart may be changed.
	Click anywhere inside the chart. Then re-size handle will appear. Place the pointer on the border in the handle and re-size the chart. The size may be decreased or increased.
	To change the position, place the mouse pointer in the center, press the mouse button and drag the picture without releasing button. Now the entire chart is moved to the selected place as per drag directions.
Format Chart Area
	To format the area, select the chart and right click the chart and select the option format chart area.
	The following dialog box appear.
 

 
Data Filter

	Data Filter can be used for filtering data. The filter may be Auto Filter or Advanced Filter.
	DataFilter
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